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About this manual
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About this manual
This manual describes how to install and run the Elysium ProSW translator. It 
was written for both system administrators and end-users, although the 
installation instructions require some familiarity with basic Unix or NT 
systems administrations tasks and general networking concepts.

For more information about installing, configuring, and running the Elysium 
License Server software, see the Elysium License Server User’s Guide.
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About ProSW
Elysium ProSW is an application used to translate Pro/ENGINEER solid 
models into Parasolid files (.xmt files). ProSW runs as a Pro/ENGINEER 
application, so you need to have Pro/ENGINEER installed and properly 
licensed in order to use the ProSW translator.
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8 Pro/ENGINEER to/from SolidWorks Data Translator User’s Guide, Version 1.0
Modified 9/28/01



Getting started with ProSW
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Getting started with ProSW
Requirements

ProSW is supported on the following platforms:

HP-RISC/HP-UX

SGI/Irix

IBM/AIX

Sun SPARC/Solaris

Windows NT (Intel)

Pro/ENGINEER version 2000i or 2000i2, with manufacturing code 1999390 or 
later. Versions with earlier manufacturing codes may import data 
inconsistently. The Pro/ENGINEER manufacturing code is printed on the 
Pro/ENGINEER CD. Alternatively, you can check the manufacturing code 
while running Pro/E by opening the Help->About Pro/ENGINEER window.

SolidWorks 2000, 2001

Imfomation about SolidWorks to Pro/ENGINEER translation 

Units

ProSW uses millimeters (mm) as the default units.

Accuracy

Generally, ProSW maintains a geometric accuracy of 0.01 mm. However, if 
Pro/ENGINEER’s accuracy lower bound is greater than 0.01, the model is 
translated using that accuracy lower bound. Pro/ENGINEER’s accuracy lower 
bound is given by the following formula:

model_size* accuracy_lower_bound

where model_size is the length of a diagnonal of the bounding box associated 
with the solid model.

ProSW uses a default value of 0.0001 for accuracy lower bound tolerance. You 
can change that value by setting the apporpriate parameter in the 
Pro/ENGINEER configuration file. The valid range is 0.0001 to 0.000001.

For example, if the model_size is 1 m, the default accuracy lower bound is 0.1 
mm (1000 * 0.0001). If you set the accuracy lower bound tolerance to 
0.000001, the accuracy lower bound is 0.001 mm.
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Installing license server files

The Elysium license server manages the varioius software licenses to Elysium 
products. The client-server architecture allows you to run Elysium products on 
different machines on your network, subject to the number and type of licenses 
for a particular product, expiration dates, and so on.

Although you do not need to have the license server running in order to install 
ProSW, you will need to have it running in order to use ProSW to perform 
translations. You will also need a valid ProSW license password.

For instructions to install and configure the Elysium license server software, 
see the Elysium License Server User’s Guide.

General installation notes

The installation process for both Unix and Windows NT platforms involves 
copying files from the installation media (CD) to your hard drive
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Installing ProSW files on a Unix system
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Installing ProSW files on a Unix system
1. Mount the CD-ROM.

Hints for using the CD on Unix platforms:
On HP-UX systems use

mount -F cdfs -o cdcase,ro /dev/dsk/c1t2d0 /cdrom

The "/dev/dsk/..." will depend on your hardware configuration.

For AIX, use

mount -v'cdrfs' -f'' -r'' /dev/cd0 /cdrom

Recent versions of Solaris and IRIX will automatically mount a CD, provided your 
Volume Management daemon (vold) is running properly.

2. Create a directory to install the ProSW files.

3. Change directory into the ProSW installation directory.

You will need to run the installation script in the directory you create in Step 2, as 
the script creates subdirectories and installs the files into the current directory 
when it is executed.

4. Run the install script.

You’ll need to supply the following information to the installation script: the 
installation or target directory; the source directory, i.e., the CD filesystem; the 
product number of the ProSW translator; the version of Pro/ENGINEER you have; 
the license server hostname; the license client/server port number.
How you start the installation script depends on the particular Unix platform you’re 
running.

HP-UX: cd_mnt_dir/INSTALL/SETUP\;1

IRIX: cd_mnt_dir/install/setup

AIX: cd_mnt_dir/install/setup

Solaris: cd_mnt_dir/cdrom0/install/setup

Where cd_mnt_dir is the path to the directory where you mounted the CDROM. 
Follow the instructions given by the installation script to install ProSW.
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5. Verifying the installation

You can compare your installation with the one shown below

config.pro

elys.ver

protk<ProE_version>.dat

pro el_pall_hist

el_psec_info

protk<ProE_version>.dat

SHIPnumber proe_export <ProE_version> <platform> adeKernel.exe

proe2nut.exe

nut2sw.exe

pronutenv.txt

protk.dat

prodlist.txt

text_pronut text From elysium.txt

To to_ev3d.txt

proe_import <ProE_version> <platform> adeKernel.exe

nut2proe.exe

sw2nut.exe

pronutenv.txt

text_nutpro text elysmsg.txt

ntprmsg.txt

menus topro_opt.mnu
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Installing ProSW files on a Unix system
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Completing the installation on a UNIX system

You’ll need to copy the protk.dat file (renamed from protkproe_ver.dat) 
and the config.pro file to the directory where ProE is started in order for 
ProE to recognize the ProSW translator. If files by those names already exist in 
your ProE start-up directory, merge the contents of the files created during the 
installation, above, into the existing files.Where,

INSTALLDIR is the location of the installation directory.

SHIPnumber is the ship number of the installation CD.

<proe_version> is the version of ProE, such as 2000i or 2000i2,
that you have installed.

<platform> is the UNIX version, such as sun or aix.

The file will contain the following information,

NAME From_ProE_SHIPnumber

EXEC_FILE INSTALLDIR\SHIPnumber\proe_export\<proe_version>\ 
<platform>\pro2nut.exe
TEXT_DIR INSTALLDIR\SHIPnumber\proe_export\text_pronut

REVISION 23

END

NAME To_ProE_SHIPnumber

EXEC_FILE INSTALLDIR\SHIPnumber\proe_import\<proe_version>/ 
<platform>\nut2pro.exe
TEXT_DIR INSTALLDIR\SHIPnumber\proe_import\text_nutpro

REVISION 23

END

Caution: If you find the above lines in your existing protk.dat file, remove that 
block of text from the file using your favorite editor, then merge in the contents 
of the protk<proe_version>.dat.

For additional information about the ProE configuration file, config.pro, see 
Pro/Help or the ProE documentation.
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Installing ProSW files on a Windows NT system
You need Administrator privileges in order to install ProSW.

Insert the Elysium Translator CD into your CD-ROM drive. The Elysium 
Direct Data Translators Setup program starts automatically. (If the setup 
program does not start automatically, run the \winnt\setup.exe program found 
on the Elysium Translator CD. You can do that using Run... from the Windows 
NT Start menu.) Follow the instructions given by the installation wizard.

Configuring files required to run ProSW (runtime files)

In order to complete the installation of ProSW, you need to create/edit and 
install three files: protk.dat, prodlist.txt, and config.pro. We provide an 
interactive utility, ProeSet, to help with that. You can run it by selecting 
Translator setting for ProE from the Windows NT Start menu (look in the 
Elysium Translators folder under the Programs folder).
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Installing ProSW files on a Windows NT system
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Click Edit in order to select the particular version, or ship number, of the Pro/E 
to/from SolidWorks translator you are installing.
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You are returned to the initial window, and you should see an entry for the 
Product Name and Ship Number you selected.
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Installing ProSW files on a Windows NT system
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Click Create. The following files are created.

– INSTALLDIR\SHIPnumber\proe_import\<proe_version>\nt\
prodlist.txt

– INSTALLDIR\SHIPnumber\proe_export\<proe_version>\nt\
prodlist.txt

– INSTALLDIR\pro\protk<proe_version>.dat
– INSTALLDIR\pro\config.pro
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where INSTALLDIR is the directory where the ProSW translator software is 
installed, SHIPnumber is the actual ship number, e.g., SHIP200031, and 
<proe_version> is either 2000i or 2000i2.
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Installing ProSW files on a Windows NT system
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Completing the installation on a Windows NT system

You’ll need to copy the protk.dat file (renamed from 
protk<proe_version>.dat) and the config.pro file into the 
ProE_installation_directory/text directory for ProE to recognize the ProSW 
translator. If the protk.dat file already exists in your ProE/text directory, merge 
the contents of the file created by the ProeSet utility, above, into the existing 
file.

NAME From_ProE_SHIPnumber

EXEC_FILE INSTALLDIR\SHIPnumber\proe_export\<proe_version>\nt\
pro2nut.dll

TEXT_DIR INSTALLDIR\SHIPnumber\proe_export\text_pronut

REVISION 23

STARTUP DLL

END

NAME To_ProE_SHIPnumber

EXEC_FILE INSTALLDIR\SHIPnumber\proe_import\<proe_version>\nt\
nut2pro.dll

TEXT_DIR INSTALLDIR\SHIPnumber\proe_import\text_nutpro

REVISION 23

STARTUP DLL

END

Caution: If you find the above lines in your existing protk.dat file, remove that 
block of text from the file using your favorite editor, and then merge in the 
contents of the protk<proe_version>.dat.

For additional information about the ProE configuration file, config.pro, see 
Pro/Help or the ProE documentation.
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Running ProSW on UNIX and WINDOWS systems

Start Pro/ENGINEER.

The following messages are displayed as ProE reads in the menu text for the 
ProSW translators from the protk.dat file.

>>>Exec file:
/home/proe/SHIP200112/proe_import/2000i2/sun/nut2pro.exe
>>>Text dir : /home/proe/SHIP200112/proe_import/text_nutpro
---------------------------------------------------------

Elysium Direct Data Translators
Importing to Pro/ENGINEER

developed by
ELYSIUM CO.,Ltd.

---------------------------------------------------------

>>>Exec file:
/home/proe/SHIP200112/proe_export/2000i2/sun/nut2pro.exe
>>>Text dir : /home/proe/SHIP200112/proe_export/text_nutpro
---------------------------------------------------------

Elysium Direct Data Translators
Exporting Pro/ENGINEER

developed by
ELYSIUM CO.,Ltd.

---------------------------------------------------------

Export a Pro/ENGINEER model to Parasolid file
1. Select one of the two options from the File pulldown menu in ProE.

File > Elysium Export(200112) > to SolidWorks

2. Enter the exported Parasolid file name after this prompt.

to SolidWorks : Enter Parasolid file Name [./defaultname.x_t]

3. Enter yes or no to one of the two prompts depending whether you are creating a 
new parasolid file or going to overwrite an existing one.

> to SolidWorks : OK to create ./defaultname.x_t? Y/N[N]

or

> to SolidWorks : OK to overwrite ./defaultname.x_t? Y/N[N]

4. You will be asked to confirm this operation with the following prompt.

> to SolidWorks : OK to continue? Y/Q(Q : quit) [Y]

5. When the exporting is complete, you will see the following prompts.

> to SolidWorks : Converting ....
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Running ProSW on UNIX and WINDOWS systems
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> to SolidWorks : Succeeded to create a Parsolid file.

Import a Parasolid file into Pro/ENGINEER
1. Select the following option from the File pulldown menu in ProE.

File > Elysium Import(200031) > from SW

2. Select the file name to open in the Parasolid File Open dialog box shown below.

3. When the Parasolid file is successfully imported, the following prompt is displayed 
in ProE.

Finish to Import Model.
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Troubleshooting
We present common startup problems first, followed by those situations that 
have to do with the solid model itself.

Common Unix startup problems

Problem: Pro/ENGINEER fails to run from the directory where the protk.dat 
file is installed.

The ProSW translator version specified in the protk.dat file might not match 
the version of Pro/E you are running. Check the version of the nut2pro.exe 
executable using the what command. For example,

cd <install_dir>/SHIPXXXXXX/proe_import/<proe_ver>/<arch>
what nut2pro.exe | more

If the versions don’t match, reinstall the correct ProSW version.

Problem: The ProSW translator logo messages do not display when I start 
Pro/ENGINEER.

Problem: Elysium ProSW Import is not listed in the Pro/ENGINEER Import 
menu.

Problem: There is no “from SolidWorks” on the Elysium Import menu.

Problem: The ProSW translator does not run after selecting “from 
SolidWorks” on the Elysium Import menu.

Common Windows NT startup problems

Problem: Pro/ENGINEER fails to run.

Problem: The ProSW translator logo does not display when I start 
Pro/ENGINEER.

Problem: Elysium ProSW Import is not listed in the Pro/ENGINEER Import 
menu.

Problem: There is no “from SolidWorks” on the Elysium Import menu.

Fixing problems with model data

In cases where a translated model does not appear at all in Pro/ENGINEER, or 
where only partial translation occurs, there may be additional steps you can 
take.

In general, problems with translated data can be caused by
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Troubleshooting
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– Errors in the SolidWorks solid model
– Restrictions in the translator’s runtime environment (memory, swap, and so 

on)
– Bugs in the translator software (highly unlikely, we think!)

When contacting Elysium tech support, be prepared to provide the error 
messages, if any, that you see in the ProE start-up window and error messages 
that may have occured when creating the Parasolid file from the SolidWorks 
model.

Modifying the translated model in Pro/ENGINEER

Invalid data (faces, volumes) in Pro/E can often be fixed using the following 
Pro/E functions

– Feature/Redefine/Heal Geometry/Manual/Fix Bndries/Zip Gaps
– Feature/Redefine/Heal Geometry/Manual/Fix Bndries/Edit Bndry
– Feature/Redefine/Attribute
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